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Getting Started 
 

Accessing Content Administration Tools 
Content for the site is managed  through CQ5, a browser-based content management system (CMS). In order to manage 

content, you must first log in to the system. Your credentials to access the CMS are the same as those used to access 

other resources on Radford University’s network. 

Logging In 

 To access the login page, visit https://author.radford.edu. Please note that you must use “https” to login. If you 

are off campus, you will be required to be on Radford University’s Virtual Private Network (VPN). 

 Sign in using your username and password. 

 Click “OK.” 

 Click on “Websites” (see image below). Everything you do within the CMS will be done in this area of the site.  

 

 

 

 

Getting Around 

 

Double clicking on any page will open up that page in Edit mode in a new tab, 

leaving your Websites dashboard available behind it. Once in Edit mode, a 

floating toolbar, called the “Sidekick,” will appear with options to use 

different views, including: 

 Edit mode,  Preview mode, and Websites (see right). 

 

https://author.radford.edu/


NOTE: You will not be able to make edits to any pages for which you do not have permissions. 

 

Logging Out 

 

The option to log out of the CMS changes depending on where you are. On the welcome screen (partially pictured 

above), the option to sign out will be next to your name. 

After entering any of the sections made available on the welcome screen (e.g. Websites, Digital Assets, Tools, etc.), the 

option to log out is made available in the top right corner of the window. 

 

 

 

  



Adding and Editing Content 
 

Creating Pages 

 From the welcome page, click the “Websites” button to get to the Website Manager. 

 To get to your site, expand (+) the file labeled with your site’s name. This will show you the top level of the site. 

You should be able to see each section. You can expand and/or select each section to see the pages within it.  

 Expand the sections until you come to the place where you want to add a new page. If you want to add a page 

“within” or “underneath” an item, then click on the item itself. Let’s say you want to add a page underneath 

“Our History.” Select “Our History” in the left navigation. 

 

 

 



In the right area, click the “New…” dropdown and select “New Page….” 

 

 

 

 Fill in the “Title,” which will appear as the main page title and in the left sub-navigational menu (“sub-nav”). 

 Fill in the “Name,” which will appear in the URL. This cannot have any spaces (we recommend replacing spaces 

with hyphens *“-”+). 

Example:  

Title: New Page 

Name: new-page 

Adding Content to a New Page 
To add content to your new page, double click on it in the left navigation. That will open the Page Editor in a new tab in 

your browser and you’ll be able to edit it from there. 

If you want to return to the Website Manager, you can either return to your previous browser tab, or click on the 

Websites button at the bottom of the Sidekick. 



 

 

When using the Page Editor, you have the opportunity to affect or view the page in a number of modes. The mode you 

are first placed in when visiting the Page Editor is “Edit mode.” This enables you to add new content or edit and remove 

existing content. 

To add new content,  you must first figure out what type of content you’d like to add. Most of the time it will be “Text.” 

Sometimes you may want to add “Text & Image.” Other times, content may be added that falls into the sidebar. 

 

Adding and Formatting Text 
In the Page Editor, a floating toolbar called the Sidekick is always present. It contains 

different groups of “components” or “content types.” Currently, those groups include: 

“Calendar,” “Form,” “Radford Core,” “Radford Sidebar,” and “Other.” There are several 

other groups which contain many other components, but they’re either unused or 

inappropriate for the particular types of pages that you’ll be working with. It’s possible, 

over time, as the website evolves, that more components and groups will appear that 

enable additional functionality. 

Within the “Radford Core” group, you’ll see a number of different components that can 

be added to the page. You can drag and drop them onto the placeholder (dotted-

rectangle that says “Drag components or assets here”). 

If you want to add paragraphs with the option to add bullet lists, indented text, links, 

etc., you can drag and drop the “Text” component onto the placeholder. 

Once you’ve done this, you’ll see your new paragraph area, selected with an orange box around it, like this: 

 



 

 

Double click on it to open the editor. From there you can add content 

and format it as appropriate. If you would like to edit the content within 

the context of the page, click the component once when it is orange 

instead of double clicking it. The orange box will turn green, and 

content can be edited or added directly without opening the editor. 

NOTE: Not all components provide in-context editing like the Text 

component. Also, in-context editing only offers a subset of the 

available options made available by the full rich text editor. For quick 

and simple edits, in-context editing, when available, is easy and 

convenient. 

 

NOTE: Certain components can only be added to certain areas of the 

page. Dragging a component from the Sidekick will give a visual cue as 

to whether or not the component can be dropped on the page in a 

given area. See Figures 1 and 2. 

 

Adding a Header 

 Drag and drop the “Content Heading” component onto the 

placeholder on the page from the Sidekick. Then double click on “Page Heading.” 

 Select the size of the header (Large, Medium, or Small). 

 Add the “Heading Text” and select “Okay.” 

 

Adding a Link 
While inside the editing mode for the text component, you can add a link. Select the phrase that 

you’d like to link and click the “Hyperlink” button.  

Then you can 1) add a URL that you’d like it to link to, or 2) select the “Browse” button (to the right) to select a page 

from the CMS or a file from the Digital Asset Manager.  

Figure 1 

Figure 2 



Adding a List 
While you’re still in the editing view of the Text component, you can add a bullet list by selecting the 

“Bullet List” button or an ordered list by selecting the “Numbered List” button.  

Special Formatting  
If you have a quotation or some block of text that you would like to inset, select the text and click on the Style 

dropdown, then select the “Inset” style. 

 

 

 

To create the “bold lead-in” for a text paragraph at the beginning of a page, select the appropriate text (usually the first 

complete phrase, or the first sentence if it’s very short), then in the Style dropdown, select “Bold Lead-In.” 

Other Style changes (for example, H2 and H3) are handled differently (see below). 

 

Page Properties  
To change Page Properties, see the tabs at the top of the Sidekick. Click on the 

second tab from the left and select “Page Properties….” The Page Properties dialog 

will open for the current page.  

From this dialog box you can change the Title of the page. Note: This will only 

change the page title and will not affect the name of the page (what shows in the 

URL). 

 



 

 

If you select the “Hide in Navigation” checkbox, this will remove the page from the primary (top) and secondary (left) 

navigation menus. 

If you select “Hide Right Sidebar,” this will hide the right sidebar and make the content expand to the right side. 

Checking “Full Width” will remove the left column/sidebar, which includes the sub-navigational menu. The right sidebar 

will continue to show if the “Hide Right Sidebar” option is not checked. 

For space reasons, you may want to have a shortened version of your Page Title in the left navigation. You can do this by 

adding a new “Navigation Title” and “Subnavigation Title.” You will need to apply the change to both of those in order to 

make them appear in both locations. The “Subnavigation Title” will change what it says in the dropdown menu. The 

“Navigation Title” will change what appears in the left navigation. If you change the “Navigation Title” or the 

“Subnavigation Title” but would like the Page Title to stay the same, you will also need to put that in the “Page Title” 

field, even if it appears in the “Title” field above. NOTE: To avoid user confusion, variations of the Page Title should be 

made only when necessary and limited to true abbreviations and other commonly intuitive variations. 

 

Deleting a Component 
Right click on the component you would like to delete and select “Delete.” Click “Yes” to confirm. 



 

Adding Sidebar Content 
 

There are three different sidebar types: 

 

 

 

To create a sidebar with a header: 

 Double click on the placeholder located on the right side of the page.  

 Select “Sidebar Content.”  

 Add the heading to the “Title” field. 

 If you would like to have a button link at the bottom of your 

sidebar content, add the phrase that you would like linked in 

the “Button Label” field. Add the URL or select a page or file you 

would like the button to link to and click “Okay.” 

 Add content to the sidebar by double clicking the placeholder 

and selecting the “Text” or “Image” component. 

To create a sidebar with a photo header: 



 Double click on the placeholder located on the right side of the page.  

 Select “Sidebar Content.” Leave the “Title” and “Button Label” fields empty and click “Okay.” 

 In the white placeholder, drag and drop an “Image” component from the Sidekick. After adding an image, 

double click or right click and select “Edit” to go into Edit mode.  

 Under the “Advanced” tab, you can add “Alt” text and a “Description.” This “Description” will appear as the 

image caption. 

To add content to this type of sidebar, double click on the “Drag components or assets here” box located in the gray 

placeholder of the sidebar component (pictured below). 

 

 

 

To create a sidebar with no header: 

 Double click on the placeholder located on the right side of the page.  

 Select “Sidebar Content.” Leave the “Title” and “Button Label” fields empty and click “Okay.” 

 Drag and drop the “Text” component onto the gray placeholder (pictured directly above). 

 

Disabling Inherited Components 
 

Child pages automatically inherit any sidebar components that are added to 

their parent page. For example, if a sidebar component was added to the 

Admissions landing page, then every page inside the Admissions section 

would automatically inherit that sidebar component (unless the sidebar was 

hidden on that specific page). To disable inherited components, select the 

“Edit” button in the sidebar’s toolbar. Check the “Disable inheritance” 

checkbox and click “Okay.” 



Adding Related Links 
 

 Double click on the placeholder located underneath the left navigation. Expand the “Radford Sidebar” group and 

select the “Related Links” component. 

 Click the “+” plus button to add a related link. Enter the URL or page/file that you would like to link to in the left 

field. Enter the phrase you would like linked in the “Title” field. If the referenced resource is a page managed by 

the CMS, and no “Title” was provided, the title of the referenced page will automatically be used. 

 

 

 

Adding a Promo Link 

 Double click on the placeholder located underneath the left navigation. 

 Expand the “Radford Sidebar” group and select the “Featured Link” 

component.  

 Enter the URL you would like the featured link to link to or select a file/page 

from the website directory.  

 Enter the phrase or word you would like linked and click “Okay.”  

 

Adding Columns of Content 

 In the Sidekick, expand the “Other” group and drag and drop the “2 Columns” (or “3 Columns” etc.) component 

onto the page. You will see two boxes to drop components or assets into side by side.  

 Double click in one of the boxes and expand the “Radford Core” group to add text, an image, etc.  



Adding Text & Image 
In order to make text wrap around an image on the page, you will need to add a “Text & Image” component.  

 

 

 

There are two ways to add a component to a page: 1) You can drag and drop the component (from the Sidekick to the 

placeholder). If you choose this way, you will then have to double click on the component to get into Edit mode. 2) 

Another way to add a component is to double click on the placeholder and then expand the “Radford Core” group and 

select “Text & Image.” 

Once in Edit mode, you will see this pop-up: 

 

 



 

You can add text in the “Text” tab and add an image through the “Image” tab. There are two ways to do this. You can 

drag and drop an image from the Digital Assets directory on the left side of your page. There is a search box if you know 

the name of the image you’d like to drop in. 

You can also click to upload an image, but if you 

choose this way, the image will not be included in 

the Digital Asset Manager and will not be 

available to any other page or component 

without being uploaded again. It’s best to upload 

the image to the Digital Asset Manager instead to 

encourage easy re-use of resources.  

After dropping an image in, go to the “Advanced 

Image Properties” tab to add “Alt” text, apply a 

style, add a “Description” (otherwise known as 

the caption), link it to a URL, file or page, change 

the size, or enable breaking after the component, 

etc. 

You can anchor the image left and make the text 

wrap on the right side of the image or you can 

anchor the image right and make the text wrap on 

the left side of the image. See the specs 

document previously supplied 

(radford_photo_size_specs.pdf) for 

recommended sizing and placement protocols. 

 

Selecting “Break After Image” will enable this Text & Image component to break after the image and will cause any 

following component to appear under the image instead of flowing next to it. 

 

Uploading an Image or Document 

 Return to the Day welcome screen and click the “Websites” button. 

 If you’re adding an image that you will be placing in as content then go to Websites > Digital Assets > radford, 

then select the “Content Imagery” folder. 

Click on the “New…” dropdown and select “New File….” 

 



 

 

A pop-up window will appear, from which you can browse your computer and select images to upload. 

 

If you want to upload a text file (PDF or MS Word document, for example), select the “Content Files” folder. Click on the 

“New…” dropdown and select “New File….” A pop-up window will appear, from which you can browse your computer 

and select files to upload.  

Whether you’ve uploaded an image or text file, you will then need to select the uploaded file and click “Activate” in 

order to publish that file. 

 



 

 

Publishing a Page (or Pages) 
“Activating” a page is the process that moves the page into the live website. Depending on the access granted to you, 

you might not be able to activate the web page. Instead, the page may need to be moved through a workflow before it 

can be activated. 

Workflows are processes that cause the page to be sent through a set of steps before finally being moved to the live 

website. Most commonly, a simple publishing workflow would send a new or edited page from an Author to an Owner. 

The Owner can accept the new or edited page, provide his/her own edits, or reject it, causing it to return to the Author, 

often with a message explaining the rejection. 

From Page Editor 

You can publish a page while you’re editing it by going to the “Page” tab on the 

Sidekick (second from left) and selecting “Activate Page” (see right). 

 

From the Website Manager 

 Go to the CQ5 welcome screen. Click the “Websites” button.  

 To publish a page individually, find that page in the left navigation and select 

it. Then click “Activate” (see below).  

Note: This will only publish the page(s) selected and will not publish any child 

pages. 

 



 

 

Renaming or Moving a Page 

 Go to the CQ5 welcome screen. Click the “Websites” button.  

 Find the section that contains the page you would like to rename or move. To rename or move “New Page,” 

select “Our History” in the left navigation so that “New Page” appears in the window to the right. Select “New 

Page” and click “Move…” to rename or move. 

 

 

 



A pop-up window will appear with a field called “Rename to.” After renaming, click “Move.” 

 

 

 

To move a file, select the search or “Browse” icon and find the new location.  

 

Placing an Image in a Pop-Up Window 

 If you have a large image that you would like to show in a pop-up window, you can drag and drop the “Image” 

component onto the content page from the Sidekick.  

 Select your image from the Content Finder on the left side of the window and drag it onto the “Image” 

component.  

 Once your image is in place, right click and select “Edit” (or double click the image). Add the “Alt” text and 

change the width to be “324” px . You are making a smaller version that will be linked to the pop-up of a larger 

version.  

 From the “Link” field, click the “Browse” button to search for your image in the directory *Websites > Digital 

Assets > radford > Content Imagery]. 

 Select your image and  click “Okay.” Now you are taken to the “Advanced” tab again.  

 Click on the “Decorator” dropdown and select “Pop-up Image.” You may need to publish or refresh your page 

for the Enlarge widget to appear. Remember to look at the specs document (radford_photo_size_specs.pdf) for 

recommended sizing and placement protocols.  

You can repeat this process in a sidebar component.  



 

 

 

 

 

Adding a Vimeo Video 

 Expand the “Other” group of the Sidekick and drag and drop the “Vimeo Video” component onto the main 

content box.  

 Right click and select “Edit.”  

 Enter the clip ID of your Vimeo video. The clip ID is the numeric code that appears at the end of the URL of a 

video hosted by Vimeo. For example, in the URL "http://vimeo.com/6419995,” the clip ID would be 6419995.  

 Specify the dimensions of the video (see specs document). While the height and width can be adjusted freely, 

they should match the aspect ratio of the original video to prevent skewing the image. 

 If the video is going to appear in a pop-up layer, it should be given a title and description. This content should be 

added in the “Title” and “Description” fields in the Vimeo Video editing dialog box. See the next section on how 

to open a Vimeo Video in a pop-up layer. 

 

Placing a Vimeo Video in a Pop-Up from a Sidebar 

 Create a new page (see instructions above) within/underneath the page that will have the link to the  pop-up 

video.  

 Name this page according to the video title.  

 Double click to open it in the Page Editor. Go into “Page Properties” to hide it in the navigation and to hide the 

right sidebar (see instructions for both above).  

 Double click on the placeholder, expand the “Radford Multimedia” group and select “Vimeo Video.” Enter the 

“Clip ID,” “Title,” and optionally, “Description.”  

 Leave the newly created video page and return to its parent page (or the page that will link to the pop-up).  

 Double click on the placeholder located on the right side of the page. Select “Sidebar Content.” 

 Add the heading you would like to the “Title” field and click “Okay.”  

 Drag and drop the “Image” component onto the white placeholder.  

 After dragging and dropping the image you’d like (we recommend getting a still from the video) into the “Image” 

component, right click and select “Edit.”  

 In the “Link to” field, browse for the newly created video page and select “Okay.” 

 In the “Decorator” dropdown, select “Vimeo Video.” 

 Drag and drop a “Text” component to the white placeholder in the sidebar to add a video description (or other 

content). 

  

What are Decorators? 

When an image on a page is linked to other “rich” content, such as a video or gallery, the Decorator 

tells the page to dress the image with a graphic overlay.  Applying a Decorator is not required, but it 

does help the user to identify what the image is linked to. Currently, there are three available 

Decorators: Image Pop-Up, Video and Gallery.  

 



 

Adding a Banner Image 

 Upload your banner image to the Websites > Digital Assets > radford > Banner Images folder.  

 From the Page Editor, drag and drop the “Image” component onto the placeholder at the top of the page. On 

the left side of the page in the image directory, you can search for your uploaded banner image to drag and drop 

into the “Image” component.  

 

 

 

 

 

 

 

 

If you right click the banner image and select “Edit,” you can add description text and a link. These will appear in a black 

faded band at the bottom of the banner image. 

 

  



 

Making a Table 
Tables are designed to show data in a tabular format. They have many features, visual and semantic, which help show or 

describe axial relationships between the data held by the table. Unfortunately, even simple tables can be complex 

constructs and arduous to assemble. Fortunately, the CMS has tools available to help the user construct relatively simple 

tables that will accomplish most of what is needed. 

The table tools are made available through the “Text” component. Create a new instance of the “Text” component by 

dragging it from the Sidekick and dropping it into a placeholder on the page. 

Double click (or right click and select “Edit”) on the newly added “Text” component. Once in 

Edit mode, click the “Table” button (see left) to add a table. 

 

A pop-up will appear where you can specify the number of columns and rows 

you’d like the table to have. Note: You can add and remove cells, columns, or 

rows at any time. 

In that same pop-up, you can choose if you’d rather have the “First row,” “First 

column,” or “First row and column” be the header of your table. We strongly 

recommend that all tables have at least one header. Then you can specify the 

“Width” (we recommend “100%” width for most tables). You can leave the 

“Height” blank, as this will be determined by the amount of content rows. Set 

the “Border,” “Cell padding” and “Cell spacing” to “0.” In the “Style” dropdown, 

select “Alternating Row Colors,” then click “Okay.” 

You will now have an outline of your table. If you have chosen the first row to 

be your header, then right click in that first row, hover over “Cell” and select 

“Cell Properties” (see below). 

 



 

A  pop-up will appear. Click the “Style” dropdown and select “Header 1,” then select “Apply to Entire Row.” 

 

Which style of header you choose to apply depends on the data being entered into the table. The “Header 2” style is less 

emphasized, and usually only used in conjunction with “Header 1” as a way to visually distinguish between a primary 

header, and a secondary header. 

 

You also have the “Horizontal align” dropdown, where you can specify if you’d like your text to align left, center or right. 

Below that is the “Vertical align” dropdown, where you can specify if you’d like your text to align top, middle, bottom or 

baseline. 

“Header 1” “Header 2” 

/content/radfordcore/home/admissions/paying-for-college/undergraduate/aid/student-employment.html 



If you right click on a cell and hover over “Cell,” you will see the options to “Merge right” or “Merge down.” 

To add or remove rows, right click, hover over “Row” and select “Insert before,” “Insert after” or “Remove.” Same is true 

for a column. 

Tip: Pressing your tab key will jump you to the next cell. Once it is in the last cell, pressing the Tab key will automatically 

create a new row. 

Note: Even though it is not pictured in Edit mode, the header text will automatically align left. 

We generally put tables in their own text component but you can add content before or after the table. To do so, right 

click on the table and select “Insert paragraph before table” or “Insert paragraph after table” (see below). 

 

 

 

To add a title for the table, you must switch to source editing mode by clicking the  

“Source Edit” button. The visual table editor currently provides no way to help you do this. 

If the table is the first thing in your “Text” component, then you should see a <table> tag at the top (for example, <table 

width="100%" cellspacing="0" cellpadding="0" border="0" class="alternating-rows">). Directly after this table tag, add 

the following caption tag with your title in between the opening and closing tags:  

<caption>Table Title</caption> 

 



 

 

The <caption> tag is a semantically strong method of adding a title to a table. While you could add a separate “content 

heading” component or an “h3” or “h4” header prior to the table, it wouldn’t have the same styling, nor the same 

semantic association with the table that it precedes. 

 

Adding a Slideshow/Photo Gallery 
 

 First upload the images you’d like to add to the Photo Gallery. In the Website Manager, navigate to Websites > 

Digital Assets > radford > Gallery Images.  

 Here, select the “New…” dropdown and click “New Folder…”  

 Label it accordingly (for example, Name: example-gallery, Title: Example Gallery).  

 Inside the newly created folder select the “New…” dropdown and click “New File….” A  pop-up will appear 

where you can browse and upload multiple photos.  

 To add the Photo Gallery contents, create a new page in the appropriate location. We recommend placing it 

underneath the page that will be linking to it.  

 Label this new page according to the Gallery content and double click to open it in the Page Editor.  

 Go into “Page Properties” to hide it in the navigation and to hide the right sidebar (see instructions for both 

above). 

  In the Sidekick, expand the “Other” group and drag and drop the “Gallery” component onto the placeholder on 

the page. After doing this, a new component called “Gallery Item” will appear in the Sidekick under the “Other” 

group. 

 Drag and drop the “Gallery Item” component onto the newly created placeholder. You will now see an “Image” 

and “Text” component on the page, along with an area for a Thumbnail.  

 Drag and drop your first image onto the “Image” 

component. The “Gallery Item” component will scale 

your image to the maximum width or height required 

by the Gallery.  

 To size your image to the ideal dimensions used by 

the gallery, double click the image to open its editing 

dialog. Click the “Image” tab if it isn’t already active. 

Click the “Crop” button. The “Image Crop Tools” 



floating toolbar will appear. From the “Aspect ratio” dropdown menu, choose the “Large Gallery Item” option. 

Size and position the cropping area as needed, then click the “Okay” button to dismiss the Image dialog box. 

 Then double click on the “Text” component. You will want to add a title for the image and a description. Before 

adding any content, click the “Format” dropdown and select “Heading 2.” Now, after selecting “Heading 2,” add 

your title text then press Enter to go to the next line.  

 Before adding description text, go back to the “Format” 

dropdown and select “Paragraph.” After adding 

description text, click “Okay.” 

 Repeat process for the remaining slides. 

 After activating the Gallery, find the page from which 

you’d like to link to the gallery pop-up. If you’re linking 

from an image, right click on that image and select “Edit.” 

From the “Link to” field, browse the directory and find the 

newly created Gallery page. From the “Decorator” dropdown, select “Gallery.” 

 


